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Title of Your Paper in Upper and Lower Case 

This page demonstrates the start of the body of your paper. The title of your paper goes on this 

page as well as the title page. The title should be centered at the top of the page in Title Case, as the 

example above shows. It should not be in all caps, and it should not be in bold. These are two common 

mistakes that students often make.  The paper should have 1 inch margins all around.  The font should 

be a simple font sized 10, 11 or 12. The entire paper should be double spaced, flush left margin with an 

indentation in front of the first sentence of each paragraph. No extra line spaces should be inserted 

above or below each paragraph. The introduction of your paper should tell the reader what the main 

topic and points of your paper is about, using formal language (no personal or first person language). 

This means there should be no I, me, we, you, ours, type of wording in your entire paper, unless your 

WRITTEN paper instructions for a specific class says that for a particular assignment you may use first 

person language.   The entire paper should be in the same font, check your headers and page numbers 

and make sure they are in the same font as the rest of the paper.  

Tips to Avoid Plagiarism 

 Correctly Paraphrase all information you obtained from anywhere other than your own head. 

This means you can’t just change 1 or 2 words in a sentence and think that you are paraphrasing. You 

must take the basic ideas from the source and write them in your own words. You then place an in text 

citation at the end of the sentence or paragraph that you paraphrased from someone’s work. You must 

also list this work on your reference page. Avoid using direct quotes unless the quote is said in such a 

way that to rephrase it would significantly detract from the meaning and/or impact of the statement. If 

you must use a direct quote, then you must place the quote in quotation marks and cite the reference 

with the author, date and page number (or paragraph number for a website webpage) where the quote 

can be found.  
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Organizing your Paper with Headings 

If a paper is long or covers more than one topic (such as both education and health care) you 

might want to make it easy for your reader to find specific information by using headings, such as the 

one above. APA style allows for 5 levels of headings, but the ones most commonly used are the style 

presented in the example above.  Level I heading is centered, in upper and lower case, and is bolded, 

The next Level II heading is demonstrated below, which is flush left, using upper and lower case and is 

bold.     This one is typically used for lager sections of a paper that is long enough to have separate 

chapters.    For most regular student papers, the use of headings is optional unless your written 

instructions specify that you should use headings. 

Using In-Text Citations  

When you paraphrase or quote material from a source, you must reference it both in the body 

of the paper, and on the reference page.  References in the body of the paper are called in-text 

citations.  The following are two examples of in-text citations from a publication with one author.   

Kessler (2003) found that the seriousness of the disease could be predicted from several factors. Early 

onset of the disease process resulted in a more persistent disease and serious prognosis (Kessler, 2003). 

Note that the punctuation mark (in this case a period) comes AFTER the citation, not before the citation. 

The in-text citation is treated as part of the sentence.  

This next is an example of a source with more than one author. In general, if a work has two 

authors, you have to cite both of their names and the date each time you reference the source.  If you 

are using the authors name in the sentence, use the word and between their names. If you are using an 

end of sentence citation format with the citation within parenthesis, then you use an ampersand (&) 

between the two names.  For example: According to Jones and Mayhue (2006), students entering pre-

nursing programs are usually uniformed concerning the rigors of the nursing profession.   Or if you use 
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the citation at the end of the sentence it would look like this:  Students entering pre-nursing programs 

are usually uninformed concerning the rigors of the nursing profession (Jones & Mayhue, 2006).  

If you do a direct quote or have the need to refer the reader to specific page number, you can do this 

within the in-text citation.  For example: (Morgan & McEwin, 2010, p. 180).  But page numbers are not 

required as part of the in-text citation if you are not using a direct quote. Direct quote also must be set 

off with quotation marks within the text. 

If a work has three, four or five authors, cite all of the authors’ last names the first time you 

reference the source. After that you can just list the first author, followed by the Latin term for “and 

others”, which is et al., followed by the year of publication. For example, if you have a reference that is 

cited as (Ireys, Chernoff & Stein, 2001).   You list all three authors the first time, then the next time you 

cite this same source you can cite this as (Ireys et al., 2001).   Please note the punctuation used with et 

al. and follow it exactly to receive full points on your paper.  If you have a source with 6 or more authors, 

then the first in-text citation can be in the abbreviated format. So if you have an article published by 6 or 

more authors in 2007 and the first one’s name is Jones, you would cite this as (Jones et al., 2007). The 

in-text citation would be: Jones, et al. (2007) reported their findings (note the use of the comma after 

the author and before et al. (2007) 

References Page 

Your reference page starts on a new page, with the word references centered at the top of the 

page.  Again, the entire section is double spaced, with no extra spaces between references.  The 

references are all listed using a hanging indent style. This means the first line hangs out from the rest of 

the reference, so it is easy to skim down the page and find a particular author name.  If you don’t know 

how to do hanging indents using MS Word, you can go to this site which tells you how to do it. 

http://www.dummies.com/how-to/content/how-to-make-a-hanging-indent-in-a-word-2007-

paragr.html 

http://www.dummies.com/how-to/content/how-to-make-a-hanging-indent-in-a-word-2007-paragr.html
http://www.dummies.com/how-to/content/how-to-make-a-hanging-indent-in-a-word-2007-paragr.html
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The references are listed in alphabetical order on the reference page. Only references cited in 

the paper go on your reference page, not everything you may have read about the subject. Also, if you 

cited a reference in your paper, it MUST be listed on the reference page.  Depending on the source of 

your materials, you will need to use a number of different reference format styles.  

Reference Page Tips 

 The reference page contains page numbers and the short time in the header, just like the body of 

the paper. The entire reference section is double spaced, just like the rest of the paper. All APA 

references use hanging indents, with the first line of the reference hanging over the other lines, as 

demonstrated here:  

To do a hanging indent in MS word, highlight the references you want to format, then go to the Home tab, 

look at the Paragraph section of the toolbar. Click on the small expansion arrow at the bottom 

right of this section. This will give you more options. Click in the area that says “Special” and 

select Hanging. This will format your reference section using the hanging indent style.  

Titles of Journal Articles are written in lower case - with the exception of the first word of the title 

or if the title includes something that is always capitalized (like a proper noun such as a person’s name or 

the name of a country). Note that the name of the journal is in italics and is in upper and lower case. If 

there is not a journal title, then the title of the article or book is in italics. Note that in electronic references, 

the DOI or web address is the last thing in the reference and there is no period at the end of the 

reference. Note that you do NOT include the date retrieved, or the database used. Just say Retrieved 

from and include the internet address of the journal or the DOI, if the article has a DOI. DOI is always best 

when available. Note that doi is used (not DOI) in the reference. The Title of the article is in lower case 

except for the first word and the title of the Journal is in Upper and Lower case and is italicized. 
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References 

Bennett, M. P., & Lengacher, C. (2007). Humor and laughter may influence health. Evidence –based 

Complementary and Alternative Medicine, 6(2),159-164. Retrieved from 

http://ecam.oxfordjournals.org/cgi/content/full/6/2/159 (don’t include the hyperlink) Note the 

journal name and journal volume are italicized, the journal issue is NOT italicized and there is no 

space between the volume and the issue. The issue is placed within parenthesis. 

Bennett, M. P., & Lengacher, C. (2007). Humor and laughter may influence health. Evidence –based 

Complementary and Alternative Medicine, 6(2),159-164.doi:10.1093/ecam/nem149 

Things to Note about Your Paper  

You must use the MS word header function to make your headers and page numbers appear in 

the correct location. If you type them in manually, they will move around when your instructor makes 

comments in your paper. If you don’t know how to use MS word to do this, go to the computer lab for 

assistance.  

Note the words Running head in the header.  The word head should not be capitalized. This is a 

common mistake made by students. Note that there is a page number in the right corner, without a 

period. Use the header function to place your page number. 

The words Running head must appear before the short title on the title page, but ONLY on the 

title page. On the remaining pages of the paper you should only have your short title in UPPER CASE on 

the left, and your page number on the right.   

Inserting a Running Head and Page Numbers for APA Papers. 

APA format requires a running head at the top of the first page of an essay that is different than 

the running head at the top of subsequent pages. It also requires each page, including the first page, to 

be numbered in the top right hand corner (see example below): 

Running head: DRUG THERAPY FOR ADHD                    1 

DRUG THERAPY FOR ADHD                      2 
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To add your running head and page numbers, follow these steps: 

1. Place your cursor on the first page of your document. 

2. Click on the Insert tab on the tool bar. 

3. Click on Page Number. 

4. Mouse over Top of Page and then click on Plain Number 1. A header should open up in the first page 

of your document with a 1 automatically inserted in it. 

5. Find the Design tab and click on the box in front of Different First Page 

6. Put your cursor in front of the number 1 and type: 

Running head: YOUR SHORTENED ESSAY TITLE IN CAPITAL LETTERS 

Place your cursor in front of the number 1 and hit Tab to move it over to the right side of the page. 

7. Scroll down to the header on the second page of your document and type in the heading you want to 

have on all the subsequent pages of your essay [omit the words Running head: and type in the 

shortened title of your essay in capital letters]. 

8. Press Tab to move the number 2 over to the right side of the page. 

9. Click on Close Header and Footer. 

If you need more help, go to the computer lab for assistance.  

Things to Note about the Title of the Paper 

The main title should be descriptive of your paper, not a generic name like APA paper or N102 

Research Paper and NOT the same as the short title in the running head.  The title should tell the reader 

what the paper is about, without being longer than 1-2 lines. The title should be centered, and located 

in the upper ½ of the title page.   Also note that the title of your paper goes in Title Case, which is Upper 

Case for Each Major Word.   
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The entire paper, including your title section, is double spaced.  There should be a double space 

between your title and your name etc. For papers that require an abstract, it follows the title page. 

Otherwise, the body of the paper follows the title page and begins with page number 2. 

If you are trying to cite something that does not have an author, governmental, or professional 

organization, date, journal title, etc - most likely your source is not good enough to be used in an APA 

paper. Wikipedia, newspapers, newsletters, blogs, letters to the editor, and general stuff on various 

commercial and non-commercial websites are not considered credible sources of data. When in doubt, 

show the material to your faculty member to get an opinion on the usability of the sources BEFORE you 

turn in the paper. For more examples on how to do specific reference types (articles with multiple authors, 

without authors, book chapters, etc, see the following websites. 

http://www.vanguard.edu/faculty/ddegelman/index.aspx?doc_id=796 

http://gethelp.library.upenn.edu/PORT/documentation/APAintext.html 

 

http://www.vanguard.edu/faculty/ddegelman/index.aspx?doc_id=796
http://gethelp.library.upenn.edu/PORT/documentation/APAintext.html
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